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Siemens Releases  
STAR-CCM+ v12.04
STAR-CCM+ has long been known as a 
powerful multiphysics CFD simulation 
and analysis tool, and following Siemen’s 
acquisition of CD-adapco in 2016, it is 
now part of the Simcenter portfolio. 
Version 12.04 enables automated design 
exploration and optimization with the 
introduction of the Design Manager and the 
new STAR-Innovate add-on.

The fully integrated Design Manager 
allows users to easily evaluate variations 
in geometry and operating conditions. The 
different designs can be quickly compared 
with interactive 3-D scene files and 
synchronized views. 

The STAR-Innovate add-on goes further, 
using the powerful optimization technology 
found in Siemens’ HEEDS software to 
intelligently search the design space. In 
addition, the stochastic analysis capabilities 
can help to evaluate sensitivity to small 
changes in input parameters.

Also introduced with 12.04 is the polyhedral 
DEM particle. These particles have 
corners, which in some cases provide a 
more realistic representation at a lower 
computational cost. You can read more 
about the benefits of polyhedral particles in 
this article.
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Calendar of Events 
UPCOMING TRAINING CLASSES
ATA provides comprehensive training in the use of Femap, Simcenter (formerly NX CAE), and 
NX Nastran. Upcoming training classes are shown below.

NX NASTRAN WITH FEMAP
 
Introduction to Dynamics Analysis

Introduction to Finite Element Analysis

Introduction to Dynamics Analysis

DDAM Analysis

Advanced Dynamic Analysis

NX NASTRAN WITH SIMCENTER 

Introduction to Dynamic Analysis

Response Simulation

Introduction to Finite Element Analysis

Introduction to Dynamics Analysis

DDAM Analysis

Advanced Dynamic Analysis

 
FEMAP 

Introduction to Femap

NEW ON-DEMAND WEBINAR 

 
What's New in Femap 11.4
Did you miss our last webinar? Watch a recording on demand to learn about the 
newest features and tools introduced in Femap 11.4. The webinar demonstrates 
improvements to visualization, meshing, charting, and more. In addition, see two 
new APIs in action, including one that constructs centerlines along solid geometry 
and another that allows users to quickly preview the solver syntax for a group.
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ATA also provides a host of free training resources including tutorials, videos, and whitepapers.

Siemens 
Releases Femap 
Version 11.4
Released on June 6, 2017, Femap 11.4 
brings a suite of customer-driven 
improvements and new features to a 
variety of areas including visualization, 
meshing, charting, and solver support.

On the visualization front, a new 
autoscale feature zooms in on the 
current selection to easily identify which 
entities are selected in a large model. 
In addition, the draw/erase mode 
introduced in 11.3 now has the option to 
refine entity selection from the previous 
selection rather than the entire model.

For geometry and meshing, a new 
command is available to split curves 
at all intersections, and the meshing 
toolbox can now automatically update 
rigid elements attached to geometry. 
Vectors and planes can be saved to 
the model for future use, tables and 
functions are easier to create with new 
GUI-based tools, and data mapping is 
up to 1000x faster.

Charting has been redesigned to reduce 
clutter and display only relevant options. 
Additionally, real and complex data can 
be plotted simultaneously, and output 
processing is available in real time.

Solver support has been improved for 
strain curvature outputs and large input 
files with many DMIG entries, and a 
powerful new API tool places centerlines 
along solid geometry.

Download Femap 11.4 from GTAC today!
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http://www.ata-plmsoftware.com/training-classes/introduction-to-dynamic-analysis-with-femap-for-prepost/
http://www.ata-plmsoftware.com/training-classes/introduction-to-finite-element-analysis-with-femap-for-prepost/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-introduction-to-dynamic-analysis-2/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-ddam-analysis-2/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-advanced-dynamic-analysis-4/
http://www.ata-plmsoftware.com/training-classes/introduction-to-dynamic-analysis-with-simcenter-prepost/
http://www.ata-plmsoftware.com/training-classes/response-simulation-2/
http://www.ata-plmsoftware.com/training-classes/introduction-to-finite-element-analysis-with-simcenter-prepost/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-introduction-to-dynamic-analysis-4/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-ddam-analysis-4/
http://www.ata-plmsoftware.com/training-classes/nx-nastran-advanced-dynamic-analysis-2/
http://www.ata-plmsoftware.com/training-classes/introduction-to-femap-2/
http://www.ata-plmsoftware.com/resources/on-demand-webinar-whats-new-in-femap-11-4/
http://www.ata-plmsoftware.com/resources
https://download.industrysoftware.automation.siemens.com/
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Tips and Tricks 
NX: FIND COMPONENTS IN LARGE ASSEMBLIES
In a large assembly, an individual part can be easily selected by searching its name or part 
number in the Find Components command, located on the Assemblies tab. Inside the 
command, use the "By Name" tab to search for the component name or number, or search 
from a list of part names on the "From List" tab. Once the desired part is selected, it can be 
found in the assembly part tree by right-clicking the top row of column headers and selecting 
"Expand to Selected."

FEMAP: SAVE USER LAYOUTS AND REUSE VIEWS
Both the user interface layout and view settings can be saved for quick future access. The 
user interface layout controls menu and toolbar settings, panes, shortcut keys, and user 
commands. Save and load these layouts at File → Preferences under the User Interface tab. 
Model views can save the model orientation, contour type, background and text colors, and 
other settings. To save a view, first copy or rename the current view title at View → Create/
Manage.  Save or load views to libraries from the view manager or from the Visibility window 
(Ctrl + Q). A library view can be assigned as the startup view by setting the appropriate library 
view number at File → Preferences under the View tab. 

NASTRAN: BCTPARM, RESET FLAG
In a SOL 101 model with contact and multiple subcases, the default is for each subcase to 
begin from the final contact status of the previous subcase. To begin each subcase from the 
initial state, set the RESET flag on the BCTPARM card to 1.

Recent News 
Siemens Partner 
Success Series 
Highlights ATA
Siemens recently interviewed ATA's Dan 
Kuriger to discuss how our specialization 
and analysis-driven design approach 
benefits both our services and software 
customers. He also reflects on the 
opportunities presented by being a 
Siemens partner and why Siemens 
continues to expand their variety of analysis 
tools. Watch the short video here.

ATA Engineers Win ASME 
Best Paper Award
The technical paper, presented at the 
2016 IGTI Turbo Expo in Seoul, South 
Korea, presents the design and full-scale 
demonstration of an engine air-brake 
nozzle. Learn more.

ATA Releases New 
Versions of IMAT and 
Vibrata
IMAT 6.3.0: IMAT facilitates the 
manipulation of test and simulation data 
in MATLAB. In addition to supporting 
more datasets from Nastran 10 and 
Abaqus 2016, this release also simplifies 
the process of partitioning and listing 
shape coefficients and results. A GUI has 
been added to improve accelerometer 
selection and results processing, and color-
coded coordinate traces provide a clearer 
understanding of coordinate groupings. 
Read more and download the latest version 
of IMAT here. 

IMAT4XL 6.3.0: This stand-alone GUI linking 
IMAT import, export, math, and plotting 
functionality to Microsoft Excel has been 
updated to utilize the latest versions of 
IMAT and Excel. Learn more about IMAT4XL 
here.

Vibrata 1.6.5: Vibrata is a comprehensive 
modal dynamics toolkit to predict response 
to transient, harmonic, random, and 
response spectrum excitation. This release 
adds documentation and enhancements 
to the Force Limiting GUI and clarifies stress 
output for bars and beams. Learn more 
about Vibrata here.

New Resources
NX: Changing Units in an 
Assembly
Creating assemblies with multiple 
parts that have inconsistent units can 
cause problems when components 
are created and referenced, as well 
as in the simulation files. To avoid 
challenges and analysis errors, it 
is best to use a single system of 
measurement throughout the model 
tree. This paper explains how to check 
units in an NX file and how to use an 
NX utility to change the units for an 
assembly file and all referenced part 
files.

Femap: Find Solid Centerlines
This API for Femap 11.4 adds 
centerlines to one or more solids, 
and each new curve is assigned a 
specified material and property with 
correct cross section, reference point, 
and orientation. Curves with matching 
circular cross sections will use the 
same property, and the centerlines 
will be placed into a new group to 
assist with reviewing. Note that the 
program may have limitations for 
processing multiple curvature solids.

Femap: Preview a Group's Bulk Data
There are a variety of situations in which it 
can be helpful to preview the solver syntax 
of a model prior to solving it, such as when 
you need to verify properties and materials 
or quickly copy components into another file 
manually. This API writes a group’s bulk data 
to a text file and attempts to open it with the 
defined program. Before first use, the user 
should edit the API to specify the text editor 
and file location to use. In addition, the user 
can choose to preview the active group or 
to select the group from an interactive list, 
and the field format can be chosen from the 
standard options. Note that after the API is 
added to Femap, these preferences can be 
changed by editing the copy of the API located 
in the Femap directory.

http://www.ata-plmsoftware.com/siemens-partner-success-series-ata-engineering-inc/
http://www.ata-e.com/news/ata-engineering-led-team-wins-asme-best-paper-award-for-2016-igti-turbo-expo-technical-paper/
http://www.ataengineering.com/news/ata-engineering-announces-the-release-of-imat-v6-3-0/
http://www.ataengineering.com/news/ata-engineering-announces-the-release-of-imat-v6-3-0/
http://www.ata-e.com/software/ata-software/imat4xl/
http://www.ata-e.com/software/ata-software/imat4xl/
http://www.ata-e.com/software/ata-software/vibrata/
http://www.ata-e.com/software/ata-software/vibrata/
http://www.ata-plmsoftware.com/resources/changing-units-in-an-assembly-in-nx/
http://www.ata-plmsoftware.com/resources/changing-units-in-an-assembly-in-nx/
http://www.ata-plmsoftware.com/resources/find-solid-centerlines-in-femap/
http://www.ata-plmsoftware.com/resources/preview-a-groups-bulk-data-in-femap/
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Issue Nine

Andy Mouron is an Engineer in the Software 
Services group at ATA Engineering, Inc. 
where, for the past seven years, he has 
supported component- and system-level 
design and analysis efforts on structures for 
the aerospace and entertainment industries.

Mr. Mouron’s expertise is in the design and 
analysis of mechanical and aerospace 
structures using multiple software packages. 
Together with ATA’s engineers, he monitors 
CAD assemblies and manages static and 
dynamic response simulations to ensure that 
full design intent is achieved on structures 
ranging from launch vehicles, satellites, 
and aircraft to roller coasters and industrial 
heavy-hauling equipment. Most of his 
projects utilize NX, Femap, and NX Nastran, 
allowing him to provide experienced 
assistance to ATA’s software customers 
through software training publications and 
hotline support. 

Mr. Mouron has a B.S. and M.S. in Aerospace 
Engineering from the University of California, 
San Diego.

Featured Instructor 

Why choose ATA?

With more than three decades of experience working with our customers to solve the most 
challenging design, test, and analysis problems, we have gained a reputation for excellence in 
the engineering community.

Our work on a wide range of products across a broad spread of industries has been recognized 
with numerous technical and service awards for excellence. This expertise and support is a 
key part of the added value we offer to all customers who purchase Siemens products from us, 
whether you are an independent contractor or a large engineering team. To provide best-in-
class support to our VAR software customers, we have established a formal hotline system that 
provides on-demand support to resolve technical issues encountered by our customers in their 
implementation of the tools. 

The hotline is staffed by experienced engineers, all of whom use these applications on a regular 
basis. ATA is also the Siemens PLM Software-preferred training provider and official developer of 
courseware for all NX Nastran training.

ATA Engineering, Inc., (ATA) is a nationwide provider of innovative, 
high-value, test- and analysis-driven mechanical engineering design 
solutions.

ATA Technical Support
Need technical assistance? Call our hotline staffed by engineers at 
877-282-4223, or visit us online. Even if you’re not a current ATA 
customer, try us out for free.

Andy Mouron

Free Software Trials
Interested in trying out Siemens PLM software? Visit our website to 
access free trials/demos of Femap and NX Nastran, NX CAD, CAM, 
and Simcenter, Teamcenter, and Solid Edge.
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